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Disclaimer: 

Before you begin, understand that I am in no way responsible for what you do 
with this information.  This write up has been written for informational 

purposes only.  In other words, use at your own risk. 

 

Credits: 

It is not my intent to take credit for work that is not mine.  The content of this 
write up is largely derived from the Internet and my own personal experience.  

If it looks like you originally wrote any part of this, you probably did, and I 
thank you for sharing that information on the Internet. 

Special thanks to Black02SS, EFILive, RedHardSupra, and all persons 
providing feedback. 

http://www.efilive.com/
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Introduction 

 

Please read the entire contents of this tutorial 
before performing any of the steps. 

 

Before you begin: 

1. The contents of this tutorial are specific to Gen III LSx PCM’s.  While the 
concepts of this tutorial are applicable to a wide variety of GM PCM’s, the 
calibration references to non-Gen III PCM platforms may not be accurate. 

2. The fuelling sections of this tutorial will provide reference to AFR, EQ Ratio & 
Lambda; however its recommended users learn to move away from AFR or in 
the very least know not to modify wide band stoich values when dealing with 
ethanol blended fuels. 

3. Upgrading to the latest release of the EFILive software will ensure all features 
are available and appear as documented. 
 
Upgrades may be downloaded, free of charge here: 
http://www.EFILive.com/latest/cat/download-EFILive 

4. Ensure you have access to a wide band O2 sensor compatible with 
EFILive/FlashScan.  This sensor must be installed, calibrated, and in proper 
working order. 

5. If you are running fuel injectors with flow ratings other than stock, 
the {B4001} “Injector Flow Rate” table needs to be calibrated to match your 
injectors. 

6. If you are running a 1999 or 2000 operating system, you should consider 
upgrading to a 2001 or later operating system.  The 2001 and later operating 
systems simplify the tuning process and provide an opportunity to upgrade to one 
of EFILive’s custom operating systems. 

 
1997 and 1998 PCM’s currently do not have the option to upgrade to a custom 
operating system. 

2001 PCM’s have custom operating systems available, however, the 2002 
based operating system offers a wider variety of custom operating system 
upgrade paths.  

 

Oxygen Sensors – Wide band vs Narrow band 

A wide band is a high precision oxygen sensor, with there being 3 common Wide band 
Sensors on the market. They are the Bosch 4.2, 4.9 LSU and NTK/Uego sensors. Most 
wide band kits utilize Bosch sensors due to costs, the 4.9 is a much faster reacting 
sensor and thus with the right controller can provide more samples per second. Being of 
a newer design the 4.9 is also less prone to contamination of the “clean air” sample like 
in the 4.2 and heat resistant. 

http://www.efilive.com/latest/cat/download-efilive
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Both sensors recommend to be “free air calibrated” often depending on use. If you think 
your sensor data is bad always check against another for peace of mind. It doesn’t hurt 
to check. 

NTK/Uego sensors are even older than the Bosch 4.2 sensors and thus are not as 
accurate/quick in sampling the air stream. 

There are a few other older “wide band” sensors on the market but I would not 
recommend using these for any critical engine tuning. 

Most GM ECU systems utilise narrow band sensors to provide minor corrections to 
fuelling, this is because as there name suggests they have a NARROW margin in which 
they can sense either a rich or lean mixture & this is only around stoich. It’s not 
recommended to tune off these alone, but it can be done, just not to any great precision. 

Sensor Location 

Most wide band controllers will mention a minimum distance from a collector merge or 
distance from a turbocharger. This is mostly due to the sensors safe operating zone, too 
close to the engine and exhaust pulses and heat will affect the sensors life span. Angle 
of the sensors is mainly to prevent fuel/water vapour from building up around the sensor 
tip. 

Analog Vs Digital 

Most good wide bands on the market now offer serial (rs232) or CAN based output 
along with an analog 0-5v signal. 

When tuning it is preferred to utilize the digital form of data from the wide band into your 
tuning software so that the data the wide band is transmitting is exactly what you see in 
the logger.  

With analog signals you can get ground offsets affecting the transmitted voltage based 
on where your powering your wide band from, even noise from the wide bands own 
electronics when producing the 0-5v output signal can cause an adjusted voltage other 
things such alternator load, car stereo systems can affect the readings you get from the 
wide band. 

Nothing is more frustrating than watching a gauge and seeing perfect fuelling and then 
finding your logger has recorded something completely different. 

Analog Wide bands: 

To be compatible with EFILive, the wide band O2 sensor’s controller must output a 0 to 
5 Volt analog voltage proportional to the measured AFR/Lambda Signal. 
 
EFILive V7.5 & V8 has built in support for the following wide band controllers in AFR: 

 Autronic 
 Innovate LC-1, LM1, MTX-L 
 PLX 
 Tech Edge 
 Wide Band Commander 

 
Other compatible wide band controllers, not listed above, can be added via a custom 
pid configured in the My Documents\EFILive\V7\calc_PIDs.txt file. See the creating 
custom PIDs section for examples. 
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It is however recommended to use a wide band with serial data output due to the 
previous issues mentioned.  

Digital (Serial output) Wide bands: 

EFILive V7.5 & V8 has built in support for the following wide band controller serial 
protocols: 

 ALM Ecotrons 
 Innovate LC-1, LM1,LM2, MTX-L 
 PLX 
 Tech Edge 1.5 & 2.0 
 AEM 
 FJO Gen1-3 
 J.A.W 
 ECM 

 
Generally what you see on your gauge display screen will be identical to what you will 
see logged via the External W02-Serial PIDs. Any difference between the two will be 
purely a millisecond response rate/delay.  

 
Not all wide bands are created equal & data speeds do vary between controllers.  

 
FlashScan V2 needs to be configured to understand the relevant data protocol from 
your wide band.  Configuration can be managed by; 
 
V8 Scan and Tune:  With FlashScan V2 connected to your PC, open V8 Scan and 
Tune.  Navigate to [F6: Devices] -> [F8: Serial I/O] and select wide band options.  Use 
the Program button to update the configuration on your FlashScan V2 device.   
 
FlashScan V2:  On the FlashScan V2 device, navigate to [F4 Options] -> [F1 Setup] 
-> [F1: Edit Settings].  Using the arrow keys navigate to: 

Option Description 

WO2 Type Select the type of Wide Band device connected to serial port*.  

WO2 Fmt Set the Wide Band controller configuration.  Bank 1, Bank 2, Both. 

WO2 Data Set the Wide Band data display format. 

WO2-1 ID Configure the ID's for multiple ECM AFR wide band controllers. 

WO2-2 ID Configure the ID's for multiple ECM AFR wide band controllers. 

Lambda vs AFR – What does it all mean? 

Since pump gas is the most common fuel available, most wide band meters are 
calibrated for the stoichiometric ratio of (14.7:1). The important part to understand is that 
the wide band meter doesn’t know (or care) what fuel it is reading. All it is looking at is 
the oxygen content in the exhaust. The wide band meter basically works natively in 
lambda and in order to display AFR, it must be told what air fuel ratio equates to lambda 
1.00 so it can display the right number. 
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So let’s assume that the wide band meter is set for a stoichiometric AFR of 14.7:1. This 
means when it is reading lambda 1.00 (regardless of fuel), it will display 14.7:1. Run it at 
lambda 1.00 on VP 109 and it will read 14.7:1. Run it at lambda 1.00 on E85 and it will 
read 14.7:1. Run it at lambda 1.00 on methanol and it will read…. Drum roll please… 
14.7:1. 

Now assume we want to run at 0.85 lambda somewhere in the map. Our wide band is 
still configured with a stoichiometric AFR of 14.7:1. 0.85 x 14.7 is 12.495:1. This means 
that regardless of the fuel type, the wide band will read 12.495 if we are running 0.85 
lambda. 

If however we adjust the stoichiometric setting in the wide band for the fuel we are 
running, everything changes. Let’s say we change to E85 and we set the wide band to a 
stoich ratio of 9.85:1. Now when the lambda is 1.00, the wide band will read 9.8:1. If we 
specify 0.85 lambda in the tune for 100kpa @ 3000rpm, we would hope to see the wide 
band read 0.85 x 9.8 = 8.33:1. 

In Short, As long as your wide band is setup for petrol/gas @ 14.7 then setup the car’s 
ecu stoich ratio to match the same figure or vice versa otherwise you could end up with 
a very large inconsistency with your BEN. Explained further below. 

This is why it’s recommended to tune & log in Lambda/EQ values because if your wide 
band controller has a modified AFR stoich ratio you could be adjusting your tune from 
incorrect data.  

A perfect example of getting it wrong 

This would be a LS1 controller set to a stoich ratio of 14.67:1 and a wide band set to 
E85 stoich of 9.8:1, say the tune is perfectly fine and is dead on accurate for the entire 
map, but you’re seeing an idle AFR of 9.8:1 so you think it’s running rich & decide to pull 
out fuel to get it back to a 14.67 afr figure, but as you pull more and more fuel out the 
engine is finding it harder & harder to run until it simply won’t start.  

The reason it won’t run is because you have pulled out nearly 40% of the fuel, now 
imagine if you have a forced induction car where you need to run richer mixtures in the 
low 12 to mid 11’s & your seeing those AFR’s but your wide band is setup for a custom 
stoich ratio of 10.5:1… Best case scenario you notice the lack of power, worst 
case…Your picking up bits of your motor off the highway as you’ve just ran the motor at 
a real gas AFR of 16.25:1. That’s why by tuning with lambda values it doesn’t matter. 

Lambda 1.00 is stoichiometric, regardless which fuel you use. 14.7:1 for pump 
gas, 13.4:1 for VP 109, 9.8:1 for E85.  
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Some GM ecu’s will work in either AFR/Lambda or EQ, EQ moves in the opposite 
direction to that of Lambda, but a number of 1 is ALWAYS Stoich. 

 

EQ Gas Stoich GAS AFR Stoich E10 AFR E85 Stoich E85 AFR LAMBDA

0.95 14.63 15.4 14.12 14.86316 9.78 10.29474 1.052632

0.96 14.63 15.23958 14.12 14.70833 9.78 10.1875 1.041667

0.97 14.63 15.08247 14.12 14.5567 9.78 10.08247 1.030928

0.98 14.63 14.92857 14.12 14.40816 9.78 9.979592 1.020408

0.99 14.63 14.77778 14.12 14.26263 9.78 9.878788 1.010101

1 14.63 14.63 14.12 14.12 9.78 9.78 1

1.01 14.63 14.48515 14.12 13.9802 9.78 9.683168 0.990099

1.02 14.63 14.34314 14.12 13.84314 9.78 9.588235 0.980392

1.03 14.63 14.20388 14.12 13.70874 9.78 9.495146 0.970874

1.04 14.63 14.06731 14.12 13.57692 9.78 9.403846 0.961538

1.05 14.63 13.93333 14.12 13.44762 9.78 9.314286 0.952381  
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EFILive Scan Setup 

Select PIDs for AutoVE in AFR 

1. Start the EFILive Scan Tool Software. 

2. Press F8 or click the [PIDs (F8)] tab page. 

3. Clear the PID selection by clicking on the “Clear existing PID selection” button 

 

4. Select the following PIDs for SD (Speed Density) tuning: 
To help locate the PIDs more easily, select the system from the drop down list, 
and then select the PID. 

System Parameter Name 

Air SAE.MAP Intake Manifold Absolute Pressure 

Conditions SAE.RPM Engine RPM 

SAE.VSS Vehicle Speed Sensor 

External EXT.ADn External Analog Voltage n 

Fuel GM.AFR Commanded Air Fuel Ratio 

Spark GM.KR Retard Due to Knock 

SAE.SPARKADV Ignition Timing Advance for #1 Cylinder 

Temperature SAE.ECT Engine Coolant Temperature 

SAE.IAT Intake Air Temperature 

Tune DYNCYLAIR_DMA Air Flow Grams/Cyl – Speed Density 

Throttle SAE.TP Absolute Throttle Position 

WO2-Analog CALC.AFR_XXXn Wide Band AFR n - XXX 

CALC.BEN_XXXn Base Efficiency Numerator n - XXX 

n is either 1 or 2 depending on which FlashScan analog input the wide band O2 sensor is connected. 

XXX is chosen so that it matches your wide band O2 controller. 

5. Save the PID file as My Documents\EFILive\V7.5\AutoVE-afr.pid by clicking on 
the “Save PID selection file with a new name” button. 

 

The final PID selection should look like this: 
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The above PIDs are the minimum for SD tuning.  You may add additional PIDs if required.  Do not exceed 24 selected channels. 

Select PIDs for AutoVE in EQ/Lambda 

As we want to deal with EQ & Lambda values, you will be required to create some 
custom PIDs before the following steps. Skip to Creating Custom PIDs if you have 
not done so already. 

1. Start the EFILive Scan Tool Software. 

2. Press F8 or click the [PIDs (F8)] tab page. 

3. Clear the PID selection by clicking on the “Clear existing PID selection” button 

 

4. Select the following PIDs for SD (Speed Density) tuning: 
To help locate the PIDs more easily, select the system from the drop down 
list, and then select the PID. 

System Parameter Name 

Air SAE.MAP Intake Manifold Absolute Pressure 

Conditions SAE.RPM Engine RPM 

SAE.VSS Vehicle Speed Sensor 

External EXT.ADn External Analog Voltage n 

Fuel EQIVRATIO Equivalence Ratio (Instead of GM.AFR) 

Spark GM.KR Retard Due to Knock 

SAE.SPARKADV Ignition Timing Advance for #1 Cylinder 

Temperature SAE.ECT Engine Coolant Temperature 

SAE.IAT Intake Air Temperature 

Throttle SAE.TP Absolute Throttle Position 

Tune DYNCYLAIR_DMA Air Flow Grams/Cyl – Speed Density 

O2-Analog CALC.AFR_XXXn Wide Band AFR n – XXX 

W02-Ben CALC.LAMBDA_XXXn Wide Band Lambda from n - XXX 

W02-Ben CALC.LAMBDA-
W02BENA 

BEN from Analog Lambda 

W02-Ben CALC.LAMBDA Wide Band Lambda from Analog AFR 

n is either 1 or 2 depending on which FlashScan analog input the wide band O2 sensor is connected. 
XXX is chosen so that it matches your wide band O2 controller. 
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Select PIDs for AutoVE via Serial 

1. Start the EFILive Scan Tool Software. 

2. Press F8 or click the [PIDs (F8)] tab page. 

3. Clear the PID selection by clicking on the “Clear existing PID selection” button 

 

4. Select the following PIDs for SD (Speed Density) tuning: 
To help locate the PIDs more easily, select the system from the drop down 
list, and then select the PID. 

System Parameter Name 

Air SAE.MAP Intake Manifold Absolute Pressure 

Conditions SAE.RPM Engine RPM 

SAE.VSS Vehicle Speed Sensor 

Fuel EQIVRATIO Equivalence Ratio (Instead of GM.AFR) 

Spark GM.KR Retard Due to Knock 

SAE.SPARKADV Ignition Timing Advance for #1 Cylinder 

Temperature SAE.ECT Engine Coolant Temperature 

SAE.IAT Intake Air Temperature 

Throttle SAE.TP Absolute Throttle Position 

Tune DYNCYLAIR_DMA Air Flow Grams/Cyl – Speed Density 

W02-Serial 

 

CALC.EQBEN_LS1 Base Efficiency Numerator – External 
W02LAM1 LS1 

W02LAM External Wide band Lambda 

 

Save the PID file as My Documents\EFILive\V7.5\PIDs\AutoVE-serial.pid by 
clicking on the “Save PID selection file with a new name” button. 

 

The final PID selection should look like this: 
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Create AutoVE MAP 

For all operating systems 

EFILIVE have included preconfigured maps for many years to do auto-ve but the 
following instructions are included so that you can always create your own. 

(See next page for additional steps for 1997 - 2000 operating systems) 

 

1. Start the EFILive Scan Tool Software (if it is not already started). 

2. Press F11 or click the [MAPs (F11)] tab page. 

3. Select MAP [A] or the first available MAP (from A to J). 

4. Press Ctrl+Enter to open the MAP property editor window. 

5. Select the [Data] tab page and check the selected check box. 

6. Select "Base Efficiency Numerator n - XXX" from the Parameter drop down list 
box, where n is the analog connection (1 or 2) and XXX is the wide band 
controller. 

7. Select the [Column] tab page and check the selected check box. 

8. Select "Intake Manifold Absolute Pressure (kPa)" from the Parameter drop down 
list box. 

9. Start the EFILive Tuning Tool Software (If it is not already started) 

10. Open calibration {B0101} “Main VE Table”. 

Select all cells by clicking in the extreme top-left, grey cell. 
Right click on any cell and select Copy with labels (Shift+Ctrl+C) 

11. Return to the EFILive Scan Tool and press the “Paste Labels” button.  The 
following labels should appear in the Col labels text field: 
,15,20,25,30,35,40,45,50,55,60,65,70,75,80,85,90,95,100,105 

Note the leading comma – it must be included. 

12. Select the [Row] tab page and check the selected check box. 

13. Select "Engine RPM (RPM)" from the Parameter drop down list box. 

14. Press the “Paste Labels” button.  The following labels should appear in the Row 
labels text field: 
,400,800,1200,1600,2000,2400,2800,3200,3600,4000,4400,4800,5200,5600,60

00,6400,6800,7200,7600,8000 

Note the leading comma – it must be included. 

15. Click the Save as button and save the map as: 
My Documents\EFILive\V7\Maps\AutoVEPrimary.map 
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Sample BEN AutoVEPrimary MAP using an LC-1 wide band. 

For 1997 - 2000 operating systems 

(See previous page for 2001 and later operating systems) 

Repeat Steps 1 to 13 from the previous section, with the following changes: 

1. In step 3, select Map [B] instead of Map [A]. 

2. In step 10, use calibration {B0103} “Backup VE Table”: 

3. In step 15, use the following filename: 
My Documents\EFILive\V7\Maps\AutoVEBackup.map 
 

 
Sample BEN AutoVEBackup MAP using an LC-1 wide band. 

Set up Open Loop, Speed Density 

1. Upload the current calibration from your PCM. 

Save 3 copies of your tune: 

i. Original Tune.tun 
ii. SDAutoVE.tun 

iii. OrgBackUp.tun 
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2. Open the SDAutoVE.tun 

 
Hint, to quickly find and display any calibration, enter the calibration ID 
including the curly braces (i.e. {B0101}) into the Navigator and click the 
[Search] button. 

3. Open calibration {B0101} “Main VE Table”. 
Select all cells by clicking in the extreme top-left, grey cell. 
Enter 15 into the Adjust text box and click the [%] button. 
This will increase all cells’ values by 15%. 

 
Note:  The increase of 15% is a precautionary measure to prevent 
extremely lean conditions that may damage your engine.   

4. If you are tuning a 1997 - 2000 operating system, repeat step 3 for the {B0103} 
“Backup VE Table”. 

5. Open calibration {B3313} "DFCO Temp Enable" 

Set it to 122 °C (252° F) 

6. Open calibration {B3618} “PE Modifier Based on RPM” 
Configure this table with the requested AFR/EQ or Lambda values you want to 
run when Power Enrichment kicks in. As an example here is a Naturally 
Aspirated target in Lambda, AFR & EQ. 

    

7. It’s extremely important you know what your commanded fuel value maps are 
displayed in especially if you are dealing with EQ vs Lambda. If you get this 
wrong bad things will happen!  



EFILive AutoVE Tutorial EFILive V7 Scan and Tuning Tool 

support@EFILive.com - 13 - www.EFILive.com 

8. You configure this by going to Edit  Properties and choosing from the drop 
down list. 

 

9. Now if you have configured your enrichment to happen via PE Mode, then you 
will need to set the following step tables to Either 1 for Lambda & EQ or 14.63/7 if 
you’re working in AFR. Alternatively you can set the PE enrichment table to all 
1’s for all rpm’s or 14.63/7 AFR etc. But you WILL need to do it 1 way or the 
other, the choice is yours. Bear in mind that the ECU will use whatever is the 
richer of the 2.  

10. If you are going to enrichen via PE, take note of the following: 
{B3613} PE MAP Threshold – This is the MAP pressure that must be met before 
enrichment can happen 
{B3618} Minimum Throttle Position for enrichment to begin vs RPM 
{B3619} Engine Coolant Temp - Additional 
If you don’t want to use PE to dial in your Fuel map then you must configure the 
following tables depending on your OS. 

11. If your tune contains {B3605}, open calibration {B3605} “Commanded Fuel When 
in Open Loop” 

 

If the calibration is displayed as EQ Ratio then set the values as per the red rectangle in this table 
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If the calibration is displayed as AFR then set the values as per the green rectangle in this table 

 

12. If your tune contains {B3647} (custom OS V3 and later), open calibration {B3647} 
“Commanded Fuel vs RPM” 

 

 

If the calibration is displayed as EQ Ratio then set the values as per the this table 
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If the calibration is displayed as AFR then set the values as per this table 

 

13. For Custom OS V3 and later, open calibration {A0008} “Open Loop ECT 
Commanded Fuel Multiplier” and set the following values: 

 

 
These settings are required for additional enrichment during engine 
warm up.  This calibration may require additional user adjustments for 
desired drivability. 
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14. Open calibration {B3801} "Long Term Fuel Trim Correction" 
Set it to Disable calibration {B4205}  

15. Open calibration {B4205} "Closed Loop Temp Enable" 
Select all cells by clicking in the extreme top-left, grey cell. 

Enter 122 °C (252° F) into the Adjust text box and click the [#] button. 

That will set all cells’ values to 122 °C (252° F) 

16. Open calibration {B0701} "Catalytic Converter Protection Enable" 
Set it to Disable. 

 
If you have catalytic converters, and get crazy on your drive, you may 
overheat and damage the catalytic converters. 

17. Open calibration {B5913} "Spark High-Octane Table" 
Select all cells by clicking in the extreme top-left, grey cell. 
Right click on any cell and select Copy (Ctrl+C) 
Open calibration {B5914} "Spark Low-Octane Table" 
Right click in the top left cell and select Paste->Paste (Ctrl+V) 

 
If you upgrade your PCM to EFILive’s Speed Density custom operating 
system, step 13 is not required. EFILive’s Speed Density operating 
system restored dual spark map and full adaptive spark control when 
running MAF-less. 

18. Open calibration {C6002} "Engine DTC MIL Enablers" 
Set P0101, P0102, and P0103 to No MIL. 

19. Open calibration {C2901} “MAF High Frequency Fail 1" 
Set it to 1 Hz. 

20. Open calibration {C2902} “MAF High Frequency Fail 2" 
Set it to 1 Hz. 
If calibration {C2902} is not available in the operating system that you are using, 
then ignore this step. 

21. Open calibration {C2903} “MAF High Frequency Fail Limit" 
Set it to 1. 

22. Pop the hood and unplug the MAF sensor (see note) 

 
Note: If your MAF has a 5-pin plug, your IAT sensor is built into the 
MAF.  You will need to make provisions to get the IAT signal into the 
PCM.  Various write-up’s on this can be found at: 
 www.EFILive.com and www.ls1tech.com.   

Vehicles equipped with automatic transmissions should go to table 
{E0104} “Transmission DTC Fault Pressure Modifiers” and set P0101, 
P0102, and P0103 to NO to prevent the PCM from increasing shift 
pressures. 

23.  For vehicles equipped with electronic throttle control, “ETC”, open calibration 
{C6101}, enter 40 into the Adjust text box and click the [%] button. 
This will increase all cells’ values by 40%. 

http://www.efilive.com/
http://www.ls1tech.com/
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Note:  The increase of 40% is a precautionary measure to prevent the 
PCM from setting DTC P1514.  Depending on engine modifications, 
users may need to further adjust this calibration to prevent DTC P1514.   

24. Save this tune and perform a calibration only reflash of this file into your PCM. 

 

Data Logging 

1. Start the engine and let it come up to full operating temperature. 

2. While the engine is warming up, start the EFILive Scan Tool software, connect to 
the vehicle and start monitoring your data (do not log at this time). 

 
To start monitoring data, click the yellow button. 
To start logging data, click the red button. 
Once logging or monitoring has started, you can toggle between logging 
and monitoring by pressing Ctrl+space bar. 

3. While waiting for the car to warm up it’s prudent to reset the learned LTFT’s, to 
do this simple press the F12 key or go to the DVT tab & select the LS1 controller 
from the drop down list. 

4. Click on Activate, then click on the learning tab & then hit the Fuel Reset button, 
you can hit it a few times for good measure but once is generally enough. 

5. Once the engine has reached normal operating temperature, usually 68° C (180° 
F) or higher, start your drive and start data logging. 

6. It helps to have a passenger viewing the BEN factor map while it is displaying the 
cell count.  You want to hit as many cells as you can, as many times as you can.  
Try to get a cell count of 50+ per cell. 

7. After you have finished logging data, save the log file as 
My Documents\EFILive\V7\Logged data\AutoVE.efi 
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Update Calibrations 

1. Start the EFILive Tuning Tool software and open the SDAutoVE.tun file. 

2. Start the EFILive Scan Tool software and open the AutoVE.efi file. 

3. Press F11 to display the [Maps (F11)] tab page. 

4. Press A to display the primary VE BEN factor map. 

5. Click the Average button to display the cell’s average logged values. 

 

6. Build and apply the following filter which excludes unwanted frames from the 
data log: 

 
Filter configuration using °F 

 

 
Filter configuration using °C 
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7. Hide all cells with a value of less than 50. 

8. Select all cells in the table by clicking in the extreme top-left grey cell, then right 
click and select Copy with labels (Shift+Ctrl+C). 

9. Switch back to the EFILive Tuning Tool. 

10. Open calibration {B0101} "Main VE Table". 

11. Right click on any cell and select Paste->Paste and multiply with labels. 

12. If you are tuning a 1997 - 2000 operating system then repeat steps 3 to 11 to 
copy/paste the VE data from map [B] to the {B0103} “Backup VE Table”. 

13. Save your tune as: 
My Documents\EFILive\V7\Bins\SDAutoVE_0000.tun  

14. Perform a calibration only reflash of SDAutoTune_0000.tun into the PCM. 

15. If necessary repeat the steps in the previous section, Data logging, and this 
section until the average cell values in your BEN map(s) are close to 1.00 (aim 
for +/- .01). 
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Return the PCM to Closed Loop, Speed Density 

 

 
Do not perform this section if you are using an EFILive custom operating 
system, V3 (i.e. 2/3 bar support) or later. 

Information Warning: 

Before switching back to closed loop you must remember that once you complete the 
following steps the ECU will not exit / switch into Power Enrichment until it meets the 
relevant requirements. Make yourself familiar with them! Refer to Step 10 in Set up 

Open Loop. 

 

1. Start the EFILive Tuning Tool software and open the Original Tune.tun file. 

2. Open calibration {C2901} “MAF High Frequency Fail 1" 
Set it to 1 Hz. 

3. Open calibration {C2902} “MAF High Frequency Fail 2" 
Set it to 1 Hz. 
If calibration {C2902} is not available in the operating system that you are using, 
then ignore this step. 

4. Open calibration {C2903} “MAF High Frequency Fail Limit" 
Set it to 1. 

5. Open calibration {C6002} " Engine DTC MIL Enablers" 
Set P0101, P0102, and P0103 to No MIL. 

6. Select menu option File->Load alternate calibration for comparison and 
select SDAutoVE_0000.tun. 

7. Select menu option File->Display calibration difference summary and locate 
the {B0101} “Main VE table” calibration in the list. Click the link to highlight 
calibration {B0101}. Then, click the Update button at the bottom right of the 
screen to copy the data from the alternate calibration to the primary calibration. 

 
If the {B0101} calibration is not displayed in the calibration difference 
summary window, then there is no difference between the primary and 
alternate {B0101} data. That can mean either your VE table was 
extremely accurate to begin with, or the AutoVE tuning process has not 
been competed correctly. 

8. If you are tuning a 1997 - 2000 operating system, repeat step 5 for the {B0103} 
“Backup VE Table”. 

9. Open calibration {B5913} "Spark High-Octane Table" 
Select all cells by clicking in the extreme top-left, grey cell. 
Right click on any cell and select Copy (Ctrl+C) 
Open calibration {B5914} "Spark Low-Octane Table" 
Right click in the top left cell and select Paste->Paste (Ctrl+V) 

 
If you upgrade your PCM to EFILive’s Speed Density custom operating 
system, step 9 is not required. EFILive’s Speed Density operating 
system restored dual spark map and full adaptive spark control when 
running MAF-less. 



EFILive AutoVE Tutorial EFILive V7 Scan and Tuning Tool 

support@EFILive.com - 21 - www.EFILive.com 

 

10. Save your tune as 
My Documents\EFILive\V7\Bins\Original Tune_0000.tun 

11. Perform a calibration only reflash of Original Tune_0000.Tun into your PCM. 

Verification 

1. Start the EFILive Scan Tool software and add the following PIDs to the 
AutoVE.pid selection file: 

System Parameter Name 

Fuel SAE.LONGTFT1 Long Term Fuel Trim – Bank 1 

SAE.LONGTFT2 Long Term Fuel Trim – Bank 2 

2. Start your engine and the Scan Tool and go for a drive. 

3. Monitor Commanded AFR/EQ and WBO2 AFR/Lambda or your BEN PID/MAP, 
they should be extremely close. 

4. Long-term fuel trims should eventually settle in the range –4 to 0. 

5. Repeat any of the above sections as necessary to achieve the desired LTFT’s. 
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Creating Custom Analog PIDs: 

1) Do yourself a favour and download a good text editor like Notepad ++ or 
equivalent. 

2) Browse to and open the following file: My Documents\EFILive\V7.5\user 
configuration\calc_PIDs.txt 

3) For every custom pid you want to show up in the scanner you must define a “slot 
definition” & the “parameter reference number” information. Think of the slot 
definition as the input information you want to take in and put limits or 
configuration about for the scanner window, like max/min values. FMT is format 
or how many values past the decimal you want to show. Each SLOT must have a 
unique name before you declare the configuration. In our case the EFILIVE 
documentation states that it must start with CLC-00- & then an unused number. 

For example an analog wide band will generally always output a 0-5v signal 
based on how much air it’s reading, but not all manufacturers will have a range 
between 10-20 afr. One might be 10-30 afr, so even though the voltages are in 
the same range, the actual air to fuel ratio is very different. To work that out there 
must be some math applied to the expression. Expressions will always reference 
either an external input (AD1-4) or internal supported pid. In this case we are 
dealing with the analog voltage signal. 

 

What we can see is happening here is that to work out the AFR we must multiply 
the voltage by 2 & and then add 10. So let’s say the wide band is outputting 2.5v, 
multiply it by 2 = 5 +10 = 15.0afr 

2.8v * 2 +10 = 15.6afr, now to work out the Lambda value we could either use 
another math expression or simply use the afr equation and then divide it by 
stoich of 14.7 & using the 2 previous voltages we get: 

 2.5 * 2 + 10 = 15.0/14.7 = 1.02 Lambda 

 2.8 * 2 + 10 = 15.6/14.7 = 1.06 Lambda 

4) The Parameter Reference Number is description information that will show up in 
the scanner that links to the slot definition. In this case the following: 

Code                                                     PRN SLOT Units    System Description 

CALC.AFR_WB1 F001       CLC-
00-001     

"AFR,lambda,V" WO2-
Analog     

"Wide Band 
AFR AD1" 
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Build an Analog Ben PID 

Since we have now built ourselves a pid to work out the incoming AFR/LAMBDA we 
want to create another pid that tells us how close we are to the requested/commanded 
fuelling. 

To do this, we need to again create a slot definition: 

 

The example in the above picture includes 2 different slot definitions that reference 2 
different calculated PIDs. The first one gives a BEN based on the data from another 
calculated pid I setup to work out the lambda value from the onboard Fuel Temp 
Pressure Sensor voltage which is pid “GM.FTPS”. 

The factory ecu often has unused 0-5v signal ports so they can be used for all sorts of 
devices, generally however most people will feed the signal wire into one of the AD 
ports on the V1/V2 units. 

The 2nd calculated slot again references another custom pid that works out the AFR & 
Lambda data from the onboard egrs sensor. So you have a clear understanding and 
follow on, here is a picture of the slot definition of that pid. 

 

Now that we have the Slot Definitions established, Let’s move onto the PRN side. 

 

As you can see from the above picture there are 6 fields that are required. 

1. Code is simply a name we are giving the PID 

2. PRN can always be F110 

3. Slot field must match the slot your providing information for 

4. Units will always be a factor for a BEN 
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5. System is simply the name of the drop down list you want the pid to show up in. 
you can use an existing field name or create your own. Just as I have here. 

6. Description is self explanatory 

 
When configured correctly you should end up with something like the above 

Creating Custom Serial PIDs 

Just like the above examples it’s pretty easy to create PIDs to deal with data coming 
from a serial connected wide band. If anything it’s actually easier as we do not need to 
know about voltages or math expressions etc. We are simply working with pre-defined 
PIDs.  

Those PIDs are: EXT.W02LAM01, EXT.W02AFR01 & EXT.W02EQR1 generally if a 
wide band transmits a serial data connection it will be transmitting lambda data. So to 
show that in the scanner we simply need to add one of the mentioned PIDs. 

Build a Serial BEN PID 

Now to build a BEN around that data we simply create a new Slot with the following 
data: 

Units                        Low High       Fmt Expression 

*CLC-00-002     

factor              0.5 1.5 .3 "{GM.EQIVRATIO}*{EXT.WO2LAM1}" 

Then a new PRN with the following: 

Code                                                     PRN SLOT Units    System Description 

CALC.EQBEN_LS1   
  
                 
   

F110 CLC-00-
002 

factor "W02-
Ben"    

"Base Efficiency 
Numerator - External 
W02LAM1_LS1" 

You then end up with: 
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Revision History: 

 

Oct 02, 2004:  

Corrected typo’s 

 

Dec 28, 2006: 

By: Andy Reyna (TAQuickness) 

 Revised credits 

Revised introduction 

 Added verbiage for ‘97+ PCM’s 

 Added conversions for Metric and Imperial units 

 Revised Open Loop commanded fuelling 

 Added verbiage for custom operating systems 

 Added notes to disabling MAF 

  

Mar 10, 2007: 

By: Andy Reyna (TAQuickness) 

 Added verbiage for ETC 

 

October 5 2016: 

By: David Christie (Tre-Cool) 

Added reference to AFR & adding in EQ & Lambda 

Added in serial wide band support information 

Added in custom calc pid information 

Added TOC 

Formatting changes 


